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1. This Document 

 

1.1. Purpose 

The purpose of this user guide is to provide step by step guidance in performing teacher 
related tasks in EdisonLearning eSchoolware. This user guide is designed as both a 
reference tool and in-depth companion to training. 

The following typographical conventions are used in this document. 

• Keys on the keyboard are pressed and denoted by uppercase font, such as  
ENTER, TAB, F9, T, and HOME. 

• Keys pressed at the same time are in sequence and joined by a plus sign, 
such as ALT+TAB, SHIFT+F3, and CTRL+SHIFT+A. 

• Objects on the screen are clicked and denoted by bold font, such as OK, 
Next, and Cancel. 

• Menu and sub-menu items are selected and denoted by the sequence of 
selections, such as, “From the menu bar, select Insert > Picture > From 
File, navigate to desired graphic, and click Insert or press ENTER.” 

• Screen, Window, Form, and Object names are denoted with title case. 

In addition to clicking with your mouse, commands on menus and screens may also have 
keyboard shortcuts that enable you to select them from your keyboard. In Windows 2000 
and Windows XP, it may be necessary to press the ALT key first to see the available 
keyboard shortcuts. 
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2. Product Overview 

EdisonLearning eSchoolware is the interface by which you can quickly and easily access 
all of your online tools in one location, including daily lessons, assignments and tests, 
grades and academic progress reports, upcoming deadlines, recent attendance, 
achievement intervention alerts and status, school and course announcements, and more. 
Students, parents, and instructors can also communicate with each other through the 
internal messaging system, and students and instructors can contribute to blogs and 
forums. 
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3. Logging Into Your Home Page

To log in to the 
support person can tell you the correct Internet address if you do not know it.

Once there, enter your user name and password, then click 

page appears:

This page contains links to and notifications about announcements, courses, grades, 
interventions,

Product User Guide for Teachers  © 2014 EdisonLearning, Inc. 
Logging Into Your Home Page 

Logging Into Your Home Page

To log in to the eSchoolware software, use a web browser to navigate to the server. Your 
support person can tell you the correct Internet address if you do not know it.

 

Once there, enter your user name and password, then click Sign In. Your teache

page appears: 

This page contains links to and notifications about announcements, courses, grades, 
interventions, and other information. 
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Logging Into Your Home Page 

software, use a web browser to navigate to the server. Your 
support person can tell you the correct Internet address if you do not know it. 

. Your teacher home 

 

This page contains links to and notifications about announcements, courses, grades, 
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You also have a student search feature. From the search results, you can click the Course 
Section link to access the Student Details screen. 

 

 

Items to note in the search results are the student’s institution and advisor, plus the ability 
to click the Course-Section link to go to Gradebook Student Details for the selected 
student’s course section. 
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4. Icon Bar 

The following icons appear at the top of all screens. Click an icon navigate to that area. 
Click Home on any screen to return to your home page. 

     

A number in the lower right corner of an icon indicates you have that many unread items 
in that area. 

Home 

Click Home on any screen to return to your home page. You may have other 

system roles assigned to you; the home icon lists the role you are currently 
logged in as. If you have other system roles, click the dropdown to select one. 

Announcements 

Click to view any system-wide announcements. Each announcement is listed 
with the date when it was posted, its course, the person who posted it, and a 
preview of the message. 

Messages 

Click the icon to open the Messages screen. 

Control Panel 

The Control Panel contains links to additional functionality. 

Sign Out 

Click to end your session. 

4.1. Announcements 

Click the Announcements icon to view the Announcements screen: 

 

This screen allows you to read announcements posted in courses and system-wide. 
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A green exclamation point beside an announcement title indicates that you have not yet 
read it. 

The bar across the top of the screen allows you to filter your messages by age and type. 

Today 

Displays announcements from today 

7 Days Ago 

Displays announcements from the last seven days 

30 Days Ago 

Displays announcements from the last 30 days 

All 

Displays all announcements 

Unread 

Displays only unread announcements 

View By 

Click the dropdown arrow to filter messages by system or course. 

Each announcement is listed with the date when it was posted, its course, the person who 
posted it, and a preview of the message. 

Click the More button to read the entire announcement. The message appears: 

 

Click Back to return to the Announcements screen. 

4.2. Control Panel 

Use this icon to access shortcuts to other areas: 
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5. Announcements 

On your home screen, the Announcements box displays school-wide and course-specific 
announcements. 

1. Click the Announcements icon at the top of the page to view your announcements. 

 

2. From the Announcements box, click an announcement to view it. 

OR 

Click View More to view the Announcements screen: 

 

A green exclamation point beside an announcement title indicates that you have not 
yet read it. 

The bar across the top of the screen allows you to filter your messages by age and 
type. 

Today 

Displays announcements from today 

7 Days Ago 

Displays announcements from the last seven days 
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30 Days Ago 

Displays announcements from the last 30 days 

All 

Displays all announcements 

Unread 

Displays only unread announcements 

View By 

Click the dropdown arrow to filter messages by system or course. Each 

announcement is listed with the date when it was posted, its course, the person 
who posted it, and a preview of the message. 

3. Click the More button to read the entire announcement. The message appears: 

 

4. Click Back to return to the Announcements screen. 

5.1. View Only One Course’s Announcements 

1. From your home screen, click a course to view its information. The course information 
screen appears. 

1. Click the Announcements tab. The main announcement screen for the course 

appears. This tab displays announcements for the course. 
2. Scroll down to view all announcements for this course. 
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6. Other Information 

The Other Information area 
contains links to other important 
areas of eSchoolware. 
Depending on your eSchoolware 
system configuration, not all of 
the items shown below may be 
available to you. Click a link to 
use a feature. 

 

 

 

 

6.1. My Files 

Click this icon to display your file storage area. You can keep documents here so you can 
access them from any PC that you use to access your eCourses. 

 

Folder Name 

Name of the current folder 

Sub Folder 

Number of subfolders in current folder 

File(s) 

Number of files in current folder 

Address 

Location path of current folder 

New Folder 

Click to create a new subfolder in current folder 

Upload Files 

Click to upload a file to the current location 
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Name 

Name of folder or file 

Size 

Size of file 

Modified Date 

Last time file name was modified 

Edit 

Click to edit the name of a file or folder 

Delete 

Click to delete a file or folder 

6.1.1. Create or Modify a Folder 

1. Click the Create New Folder button. The following box appears: 

 

2. Enter the folder’s name in the Create New Folder field and click Upload. 

3. Your new folder appears: 

 

4. Click the folder name to enter it; click Edit to change its name; click Delete to 

remove it. 

6.1.2. Upload or Modify a File 

1. Navigate to the folder in which you wish to place the file. 
2. Click Upload File(s). The following box appears: 

 

3. Click Browse to find your file: 
4. The File Upload window appears. Find your file and click Open. 
5. Click the Upload button. Your file appears in the list: 

 

6. Click the file name to view the file; click Edit to change a file name; click Delete to 

remove a file. 
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6.2. Research Center/Learning Land 

To access the Research Center or Learning Land, click their icons in the Other 
Information box. The example below shows the Research Center link: 

              

Research Center or Learning Land opens and places you in the Agora: 

 

The entire Research Center looks like this: 
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Learning Land looks like this: 

 

The various activities and features of the Research Center and Learning Land are based 
around different chat rooms. Navigation is done by clicking on the floor and doors. Below 
is a list of all rooms: 

Agora 

This main outdoor area contains all the buildings in the environment. 

Arcade 

This one-room building has mini-games to play for fun. These activities are 
unlocked with cogs. Cabinets contain links to Sudoku, chess, checkers, mahjong 
and more. Students who have outstanding interventions to perform cannot enter 
the Arcade. 

Art Gallery 

You can view other students' art and submit your own artwork here. The Art 
Gallery is located on the first floor of the Study Hall. 

Cogs Store 

This is where you can buy items with your cog points and customize your avatar. 

Help Desk 

Go here to ask questions and receive help. Help Desk is located on the first floor 
of the Study Hall. 

Learning Lab 

This room is located on the second floor of the Study Hall building, and has 
collaborative whiteboards for users to interact via drawings and diagrams. 

Lobby 

This room is located on the first floor of the Study Hall and is just for hanging out. 

Media Room 

This room has a media viewer for playing course videos. The Media Room is 
located on the first floor of the Study Hall. 
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MyClassroom

MyClassroom is 
skills from various subjects. This feature is only available in Learning Land for 
middle school s

MyPad

MyPad is an optional, fun virtual environment where you can rent an apartment 
using cogs you've earned. You can decorate your pad and even upgrade to a 
better place if you can afford it. Other students can stop in and chat with you and 
you c
Land for middle school students.

Study Hall

This room contains an interactive course catalog for 
previ
for students to answer questions fo

World Language HQ

This room is the main foyer of the World Languag
student
building
French, 
in the lan
Research Center for high school 

World Language Rooms (Chinese, French, German, and Spanish)

Each of the language rooms is dedicated to chatting in the given language. Each 
room also contains access to a world language activity called 
world language room
of computers open
world language
for high school students.

Writing Center

Use this
review by the system's writing and
in Learning Land for middle school students.

6.2.1. Art Gallery

The Art Gallery chat room 
contains an interactive image 
viewer, where students can look 
at and discuss each other’s 
artwork. All wor
submitted by students
approved by administrators for 
inclusion. 
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MyClassroom 

MyClassroom is an activity where you work with other students and 
skills from various subjects. This feature is only available in Learning Land for 
middle school students. 

MyPad 

MyPad is an optional, fun virtual environment where you can rent an apartment 
using cogs you've earned. You can decorate your pad and even upgrade to a 
better place if you can afford it. Other students can stop in and chat with you and 
you can visit other students, as well. This feature is only available in Learning 
Land for middle school students. 

Study Hall 

This room contains an interactive course catalog for you to browse and access a 
preview all of the different courses available to them. It also has a question board 
for students to answer questions for cog points. 

World Language HQ 

This room is the main foyer of the World Language HQ building, and is where 
students may access the World Language rooms. Inside the World Language HQ 
building are the four world language rooms connected by a lobby: 
French, German, and Spanish. Participants are encouraged to discuss and chat 
in the language associated with the room. This building is only available in the 
Research Center for high school students. 

World Language Rooms (Chinese, French, German, and Spanish)

Each of the language rooms is dedicated to chatting in the given language. Each 
room also contains access to a world language activity called 
world language room, there are two rows of computer terminals. 
of computers opens that room's translator, while the top row open
world language activity. These rooms are only available in the Research Center 
for high school students. 

Writing Center 

Use this building to improve your writing. You can write and submit essays for 
review by the system's writing and editing software. This feature
in Learning Land for middle school students. 

Art Gallery 

The Art Gallery chat room 
an interactive image 

viewer, where students can look 
at and discuss each other’s 
artwork. All work must be 
submitted by students and 
approved by administrators for 
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you work with other students and combine 
skills from various subjects. This feature is only available in Learning Land for 

MyPad is an optional, fun virtual environment where you can rent an apartment 
using cogs you've earned. You can decorate your pad and even upgrade to a 
better place if you can afford it. Other students can stop in and chat with you and 

an visit other students, as well. This feature is only available in Learning 

to browse and access a 
It also has a question board 

e HQ building, and is where 
Inside the World Language HQ 

age rooms connected by a lobby: Chinese, 
Participants are encouraged to discuss and chat 

This building is only available in the 

World Language Rooms (Chinese, French, German, and Spanish) 

Each of the language rooms is dedicated to chatting in the given language. Each 
room also contains access to a world language activity called Saga. Inside each 

are two rows of computer terminals. The bottom row 
top row opens the Saga 

These rooms are only available in the Research Center 

building to improve your writing. You can write and submit essays for 
editing software. This feature is only available 
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6.2.2. Avatars 

Students select an avatar with which to 
navigate rooms and chat with other users 
in real time. 

 

6.2.3. Cogs and Badges 

Cogs are points earned for successfully performing 
tasks, such as answering questions, inside 
Interactive Learning Activities. They can be used to 
buy avatar items or unlock more activities. 

Badges are marks of honor, earned for helping other 
students. 

 

 

 

6.2.4. Help Desk 

The Help Desk area contains presentations 
and guides to help users understand how to 
use the Research Center. An administrator is 
able to sign in to the Help Desk, to provide 
further assistance as a form of live help.  
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6.2.5. Media Room

The Media Room 
player for viewing videos, images,
Flash animations. Here, students wil
able to browse all of the math v

 

 

 

 

6.2.6. Sabotage

This activity 
Review for all eAcademy non
STEM courses. Students must be 
enrolled in at least one STEM course 
to be able to access 

Students have two ways to access 
Sabotage: 

• 

• 

Sabotage is an assessment activity, available from within the Research Center. 
is a board game, similar to 
lab, which lab is sabot
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Media Room 

The Media Room contains a multimedia 
player for viewing videos, images, and 

lash animations. Here, students will be 
able to browse all of the math videos. 

Sabotage 

 serves as the Unit Exam 
for all eAcademy non-core 

STEM courses. Students must be 
enrolled in at least one STEM course 
to be able to access Sabotage. 

Students have two ways to access 

 While in the Research 
Center, select Sabotage 
from the map. 

 Use the elevator inside the Study Hall building and select 
elevator menu. 

is an assessment activity, available from within the Research Center. 
is a board game, similar to Clue

©
. Players must use deduction to find out who

lab, which lab is sabotaged, and how it was sabotaged. 

Players navigate around the spaces on 
the board by answering assessment 
questions correctly, from a particular 
unit in one of their STEM

When a session ends, students may 
submit their score for a Unit Exam 
Review grade. 
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se the elevator inside the Study Hall building and select Sabotage from the 

is an assessment activity, available from within the Research Center. Sabotage 
. Players must use deduction to find out who sabotaged a 

Players navigate around the spaces on 
the board by answering assessment 
questions correctly, from a particular 

STEM courses. 

When a session ends, students may 
their score for a Unit Exam 
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6.2.7. Saga 

Each world language room contains access to a 
world language activity called Saga. The student is 
guided by an automated character called LEXI who 
is responsible for training the student and testing 
their competence. 

The game is based on espionage and the goal is to 
track down a suspect through foreign cities and 
landmarks. As the student moves from one place to 
another, they are asked to complete content-based 
puzzles. 

There are eleven distinct puzzles randomly displayed to students as they move from one 
locale to the next with LEXI’s help and guidance. 

Also available to the students is an audio translator, providing the students with 
pronunciation and translation of more than 3000 terms. 

6.2.8. Study Hall 

The Study Hall serves as a library 
setting, where users can browse virtual 
bookshelves to read and discuss any 
course lesson content from eAcademy. 
This enables students to form virtual 
study groups.  

 

 

 

6.2.9. Chat 

The participants list displays the name of the current 
chat room, the number of participants in the room 
and the names of the participants in that room. 

 

 

Online chat is the primary means of communication 
available to participants in the Research Center. All 
chat messages are automatically logged by the 
system and are time stamped. Daily logs are saved 
and can be retrieved later by system administrators. 
All reported disputes or claims of chat abuse are 
checked against these logs. 

 



eSchoolware
®
 - Product User Guide for Teachers  © 2014 EdisonLearning, Inc. All rights reserved. 

Section: Other Information Page 19 

There is also a filter in place for all chat rooms that prevents the display of inappropriate 
language. Any word that violates this filter is rendered as asterisks (*) in the chat display, 
and the offending participant is given a chat filter violation warning. The chat logs will still 
record every word exactly as it was originally typed to ensure the accuracy of the 
information available to administrators.  

A participant may receive two automatic chat filter violation warnings in a single week. 
Upon the third chat filter violation, an offense report is generated. Any offending 
participants can be "silenced" by a chat administrator, meaning they cannot send chat 
messages. The chat administrator then notifies the school's administrators, who decide 
what further action should be taken. 

Participants can report instances of inappropriate language, bullying, and harassment 
using the Report Abuse button. This button is always available on the bottom left of the 
participants list. Clicking this button opens a form for sending a chat abuse report to chat 
administrators. 

6.2.10. Social Networking 

Students can build their own avatars  maintain simple profile 
pages, post status updates, and keep track of their friends list 
as part of the Research Center’s social networking system. 

 

 

 

 

 

 

 

6.3. Tutoring/Live Events 

Click this icon to enter live classes or tutoring sessions. Depending on your school’s 
configuration, this feature may not be available to you. 

6.4. Web Mail 

If your school has configured an external email account for you, click this icon to access it. 
If this is not the case, clicking this icon stakes you to the internal-only Messaging screen. 

More...  See the Messages section for more information on using messages. 
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7. Courses

The Courses box contains l

Click the dropdown in the upper right 
current year, but you can select to view courses you graded in the past.

Click a course to view the sections 

To the right of the course name, a set of icons alerts you to any items that needs graded, 
interventions that need your attention, forum or blog posts that need your approval, or final 
course grades that are ready to be subm
sections inside that course.

The icons change color from green to yellow to red depending on how old the alerts are. 
Alerts change color every 24 hours.
thresholds. 
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Courses 

box contains links to information about your courses and students.

in the upper right to select a school year. The default setting is 
current year, but you can select to view courses you graded in the past. 

Click a course to view the sections that have been assigned to you. 

To the right of the course name, a set of icons alerts you to any items that needs graded, 
interventions that need your attention, forum or blog posts that need your approval, or final 

that are ready to be submitted. The numbers on each icon are totals for all 
sections inside that course. 

The icons change color from green to yellow to red depending on how old the alerts are. 
change color every 24 hours. All alerts exclude weekends when calculating alert 
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students.  

 

to select a school year. The default setting is the 

To the right of the course name, a set of icons alerts you to any items that needs graded, 
interventions that need your attention, forum or blog posts that need your approval, or final 

itted. The numbers on each icon are totals for all 

The icons change color from green to yellow to red depending on how old the alerts are. 
All alerts exclude weekends when calculating alert 
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If sections of a course exist that you are not assigned to as teacher, those sections will 
appear locked and you will not be able to access them, as in the example below:

Each section contains additional alert icons. 
Click on a section’s ic
need graded, interventions that need your 
attention, forum or blog posts that are unread, 
or final course grades that are ready to be 
submitted. 

 

 

Additionally, each section contains icons on the left to 
allow you to access the section’s Gradebook, course 
preview in legacy view, and 

 

 

 

7.1. Course

Click a section’s 

of configurabl
and other details about how the course is configured.
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If sections of a course exist that you are not assigned to as teacher, those sections will 
appear locked and you will not be able to access them, as in the example below:

Each section contains additional alert icons. 
a section’s icons to access items that 

graded, interventions that need your 
attention, forum or blog posts that are unread, 
or final course grades that are ready to be 

Additionally, each section contains icons on the left to 
allow you to access the section’s Gradebook, course 
preview in legacy view, and Course Control Panel. 

Course Control Panel 

section’s Control Panel icon to view its information. The system 

of configurable information about each course, such as forums, announcements, blogs, 
and other details about how the course is configured. 
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If sections of a course exist that you are not assigned to as teacher, those sections will 
appear locked and you will not be able to access them, as in the example below: 

 

information. The system provides a variety 

e information about each course, such as forums, announcements, blogs, 
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7.2. Forums 

Forums can be accessed by either clicking the section-level icon or through the Forums 
tab in the Course Control Panel. 

Course forums allow students to participate in online discussions about their courses, 
homework, exams, and other eSchoolware topics. As a course teacher, you are able to 
create, view, and manage course forums and monitor their use and content. You are also 
able to start and contribute to discussions. 

 

Create Forums 

Click to create a new forum for the course. A new forum appears at the bottom of 
the list: 

 

Enter a name, select moderation status, and click Save. 

Forum Name 

Click to enter the forum. A green exclamation point beside the forum name 
indicates that it contains unread posts. 

Order Number 

Click the dropdown to select the order in which the forum should appear. 

Ratings 

Click to view student ratings of the forum. 

Blocked Users 

Click to view, add, and remove students who are blocked from the forum. 

Edit 

Click to edit the forum description and moderation status. 

Delete 

Click to delete the forum. 
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7.2.1. View and Manage Forum Posts 

1. Click a forum to enter it: 

 

2. Within the forum, click a post name. The post appears: 

 

Block 

Mark the box to prevent the post from displaying. 

Reply 

Click to reply to the current post. 

Rate 

Click to rate the current post. 

Delete 

Click to delete the current post. 

7.2.2. Create a Forum Post 

1. Click a forum name link from the gray and white striped area on the right. The 
contents of that forum, if any, appears: 

 

2. Click New Post in the upper right. The New Post window appears: 
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Toolbar Functions 

Toolbar Element Function  

 

View or edit the document source code (for advanced users). 

Undo or redo the most recent action taken. 

 

Find and replace a word or phrase within the document. 

 

Select the entire text in the document. 

 

Spell check the text in the document. 

Applies bold, italic, underscore or strikethrough formatting to the highlighted text. 

Superscript or subscript the highlighted text. 

Sets the text alignment (left, centered, right or justified). 

Inserts a printing page break. Only impacts printed version. 

Inserts a divider line (horizontal rule). 

 

Inserts symbols & special characters (accented characters, trademark, currency 
symbol, etc.). 

Creates a table with the defined number of columns and rows. 

 
Inserts an emoticon image (smiley faces, email icon, lightbulb, etc.). 

Opens equation editor to create math formulas. 

Inserts images into the document. 

 

Styles & formatting determine the appearance and semantic value of your document. 
You may use the drop down boxes to apply styles, set the font, its size, etc. To 
remove the applied style, select the style name again. 

Changes the color of the text. 

Changes the background color of the text. 

3. Complete the following fields: 

Subject 

Title of entry 

Format Buttons 

Use these buttons to format the content of your announcement. 

Message Content 

Enter your post text. 
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Attachment 

To attach a file to the announcement, click Browse. Find and select the file, then 
click the Attach File button. 

4. When finished, click the Create button to post your entry. 

7.3. Announcements 

The Announcements feature lets you post information for all students in your course(s) to 
view whenever they log in to work. To access this feature, click a course icon in your list of 
courses to expand it, then click the Course Control Panel icon for a section, and click the 
Announcements tab. The main announcements screen for the course appears. Use this 

tab to view information about and links to announcements for the course. 

 

Create 

Click to create a new course announcement. A screen appears, allowing you to 
enter and format a message, set display dates, and attach files. 

7.3.1. Create an Announcement 

Complete the steps below to create an announcement for students in a course section. 

1. After accessing the announcements screen from the instructions above, click the 
Create button on the right to create a new announcement: 
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Toolbar Functions 

Toolbar Element Function  

 

View or edit the document source code (for advanced users). 

Cut the highlighted text to the clipboard. 

Copy the highlighted text to the clipboard. 

 

Paste the data copied to the clipboard (with or without formatting). 

 

Paste content copied from Microsoft Word or similar applications. 

Spell check the text in the document. 

Undo or redo the most recent action taken. 

Find a word or phrase within the document. 

 

Find and replace a word or phrase within the document. 

Select the entire text in the document. 

Remove the formatting from the highlighted text. 

Applies bold, italic, underscore or strikethrough formatting to the highlighted text. 

Superscript or subscript the highlighted text. 

Creates numbered or bulleted lists. 

Creates a table with the defined number of columns and rows. 

Increase or decrease the text indentation. 

Sets the text alignment (left, centered, right or justified). 

 

Converts or removes the text in hyperlinks. It may also be used to manage file uploads 
and links to files on the web server. 

 

Inserts or modifies a link anchor. 

Opens equation editor to create math formulas. 

Inserts images into the document. 

 

Inserts an Adobe Flash element into the page. 

Inserts a divider line (horizontal rule). 

 

Inserts symbols & special characters (accented characters, trademark, currency 
symbol, etc.). 

Inserts a printing page break. Only impacts printed version. 
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Toolbar Element Function  

 

Styles & formatting determine the appearance and semantic value of your document. 
You may use the drop down boxes to apply styles, set the font, its size, etc. To 
remove the applied style, select the style name again. 

Changes the color of the text. 

Changes the background color of the text. 

2. Complete the following fields: 

Message Content 

Enter the title of your announcement 

Format Buttons 

Use these buttons to format the content of your announcement. 

Content 

Enter your announcement. 

Display Date 

• Mark the Sticky button to make the announcement stay at the top of the 

list of all announcements for the course section(s). 

• Use the From and To calendar controls to set dates during which the 

announcement displays. 

• Mark the Single Day box and select a day if you only want the message 

to display on one particular day. 

• Mark the Course Intro Announcement box to have the announcement 

appear as a pop-up the first time a student accesses a course 
associated with it. 

• Only one Course Intro Announcement can be active in a 
section at a given time. 

• If edits are made to a Course Intro Announcement, all students 
will again see the announcement pop up the next time they 
enter the course. 

• If a Course Intro Announcement is needed and one currently 
exists, the existing one must be deleted before a new one can 
be created. 

• Course Intro Announcements are also available for students to 
access using the Announcements button on the student home 
page. 

Sections 

This field lists your assigned sections for all of your assigned courses. To post an 
announcement to a specific course section, click a section in the Available box, 
then click the >> button to move it to the Include box. Click a section in the 
Include box, then click the << button to move it back to the Available box. 
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If you do not select at least one course section, the announcement 
will post to all sections of the course, even those that do not belong 
to you. 

Attachment 

To attach a file to the announcement, click Browse. Find and select the file, then 
click the Attach File button. 

3. When finished, click the Create button to post your announcement. 

NOTE: If you have selected a start and/or end date in the future, you will 
see the announcement in your list with those dates listed. The students 
will not see the announcement outside of those dates. 

7.3.2. Edit or Delete an Announcement 

From the main announcement screen, click the Edit button to modify an existing 

announcement. 

From the main announcement screen, click the Delete button to remove an existing 

announcement. 

7.4. Blogs 

Course blogs allow both you and students to post written material for reading and review. 
Students use the blog feature to submit longer writing samples to you and share them with 
other students. You must approve all blog postings before they are visible to other 
students. You can also create blog entries. 

Blogs can be accessed by either clicking the section-level icon or through the Blogs tab in 
the Course Control Panel. 
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7.4.1. Create a Blog Entry 

1. Click New Blog Entry. The Create New Blog Entry screen appears: 

 

Toolbar Functions 

Toolbar Element Function  

 

View or edit the document source code (for advanced users). 

Undo or redo the most recent action taken. 

 

Find and replace a word or phrase within the document. 

 

Select the entire text in the document. 

 

Spell check the text in the document. 

Applies bold, italic, underscore or strikethrough formatting to the highlighted text. 

Superscript or subscript the highlighted text. 

Sets the text alignment (left, centered, right or justified). 

Inserts a printing page break. Only impacts printed version. 

Inserts a divider line (horizontal rule). 

 

Inserts symbols & special characters (accented characters, trademark, currency 
symbol, etc.). 

Creates a table with the defined number of columns and rows. 

 
Inserts an emoticon image (smiley faces, email icon, lightbulb, etc.). 

Opens equation editor to create math formulas. 

Inserts images into the document. 
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Toolbar Element Function  

 

Styles & formatting determine the appearance and semantic value of your document. 
You may use the drop down boxes to apply styles, set the font, its size, etc. To 
remove the applied style, select the style name again. 

Changes the color of the text. 

Changes the background color of the text. 

2. Enter a subject and content. Use the formatting buttons to modify your text or insert 
items. 

3. Click Post to submit your entry. 

NOTE: Once you post a blog entry, you cannot edit it, only delete it. 

7.4.2. Approve/Reject/Delete Blog Entry 

1. Look for an entry with Requires Approval beside its title: 

 

2. Click Approve to approve the entry. This makes the entry viewable by everyone in 

the course section. 

OR 

Click Reject to reject the entry. This places a rejected notice beside the title for the 

original poster to see. 

OR 

Click Delete to remove the entry from the blog completely. 

7.5. Course Preview 

After expanding a course, click a section’s Course Preview icon to view course content in 

legacy view. 

7.5.1. Menu 

Click the Menu tab on the left side of the screen. The course menu contains the following 

items. 

7.5.1.1. Course Info 

The Course Information page contains links to videos describing how online courses work. 
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7.5.1.2. Assignments 

The Assignments page displays your assignments, scores, due dates, and number of 
attempts for each assignment. 

 

• Sort your assignments by due date via the buttons at the top of the page. 

• Click Enter to begin the assignment. 

• Click Try Again to retake the assignment. 
Click Results to view your graded assignment. 

7.5.1.3. Report Card 

The Report Card page displays your current grade for the quarter, as well as your current 
final grade. 
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Click the More button to expand any course grade to view previous quarters: 

 

Click any quarter or final grade to view grade details for that period: 

 

 

 

7.5.1.4. Digital Book 

Use the Digital Book to type notes, insert images, or copy and paste material from your 
lessons. When you save and close the window, the material is stored to use later when you 
need to study. To access the notes and other material you saved, click the button. 

 

7.5.1.5. Course Documents 

Use the Course Documents icon to view documents relevant to the course, such as 
textbook answer keys. 

 

7.5.1.6. Text Book 

Use this icon to access the supplemental course textbook. 
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7.5.1.7. Study Planner 

Students use this icon to create a timeline for their course work. You can use it to help a 
student develop a schedule. 

 

Use the start and end date calendar controls, then click Generate. A course assignment 

schedule appears: 

 

7.5.1.8. Blog 

Use the Blog icon to create and modify blog entries for the course. 

 

 

More...  See the Blog section above for more information. 

7.5.1.9. Control Panel 

Use this icon to navigate to the Course Control Panel. 
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7.5.2. Content 

The Content tab contains the actual course you selected. The Content menu on the left of 
the window contains links to all components of the lesson. 

 

Each lesson has four pages: 

 

Main content of the lesson 

 

Summary of the Essential Instruction  

 

Links that extend beyond the basics of the objectives 

 

Visual reminder of what a student should do before taking the assessment 
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7.5.2.1. Course Toolbar Buttons 

Notice the buttons in the upper right of the lesson. These tools supplement and help you 
organize your learning. Depending on the lesson, you may only see some of these icons. 

 The Need 2 Know button opens an interactive Flash animation designed to help 

you prepare for the lesson. This short activity provides you with information needed to 
master the upcoming lesson. You are encouraged to complete the activity before you 
begin. 

 The Learning Cube button is found in lesson 15 of each unit. This interactive 

learning tool helps you understand the material covered in the previous lessons of the 
unit. You are guided through a series of activities that review the important material 
(Introduction), lead you through examples (Show Me), and give you an opportunity to 
practice (Try It). Access your assessment for the lesson and the Learning Cube tests you 
on the material. 

 The Audio Podcast button opens an audio portion of the lesson. Click this 

button to hear the Essential Instruction being read. For best results, follow along in the 
lesson while the audio is playing. 

 The Instructional Video button opens a video that supports the content of your 

lesson. After you complete the Essential Instruction and Re-teach portions of your lesson, 
click this button. 

 The Digital Notebook button opens an application where you can type notes, 

insert images, or copy and paste material from your lesson. When you save and close the 
window, the material is stored to use later when you need to study. To access the notes 
and other material you saved, click the button or click the Digital Book icon in the course 

menu. 



eSchoolware
®
 - Product User Guide for Teachers  © 2014 EdisonLearning, Inc. All rights reserved. 

Section: Courses Page 36 

7.5.3. Assessments 

Your course assessments are typically divided into: 

General Structure 

• Daily Assignments (10 points) 

• Lessons 1, 2, 3, 4, 6, 7, 8, 9, 11, 12, 13, 14 

• 5 multiple choice and true/false questions 

• Randomly pulled from a pool of questions 

• Weekly Quizzes (50 points) 

• Lessons 5 and 10 

• 19 questions, 15 multiple choice, true/false and 4 short answer 

• Randomly pulled from the pools for each of the lessons for that 
week 

• Unit Exam Review (10 points) 

• 5 questions, multiple choice and true/false 

• May be taken as many times as you wish 

• Randomly pulled from the pools for each of the lessons for that 
unit 

• Unit Exams (100 points) 

• Follow lesson 15 

• 41 questions, 35 multiple choice, true/false and 6 short answer 

• Randomly pulled from the pools for each of the lessons for that 
unit 

English Courses 

• Daily Assignments (10 points) 

• Same as other courses 

• Lessons 2, 3, 4, 6, 7, 8, 9, 11, 12, 13, 14  

• Writing Assignments 

• Lesson 1 (10 points) - 5 paragraph expository 

• Lesson 5 (25 points) - Essay Outline 

• Lesson 10 (25 points) - Essay Rough Draft 

• Unit Exam (70 points) 

• Final Draft (50 points) 

• 10 Multiple Choice, True/False 

Foreign Language 

• Daily Assignments (10 points) 

• Same as other courses 

• Lessons 1, 2, 3, 4, 6, 7, 8, 9, 11, 12, 13, 14 

• Podcasts 

• Lessons 5 and 10 (25 points) 

• Weekly Quizzes (30 points) 

• Lessons 5 and 10 

• Unit Exam (70 points) 

• Final Draft (50 points) 

• 10 Multiple-Choice, True/False 
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7.6. Grading Student Work 

The next button in a course row is for Gradebook. Gradebook is a web-based grading tool 
where you can post and track student grades, automatically calculate averages, and 
easily access a broad view of student and class histories. 

Click the Gradebook icon for a course in My Courses. The number in the blue box 

represents the amount of items for that class that require grade approvals. Click the button 
to view them. The Items to Be Graded screen appears: 

 

Back 

Click to return to the previous screen 

Breadcrumb trail 

Select your criteria to move to a different year, course, and/or section to grade 

Completed 

Displays the number of students in the selected course who are ready for final 
approval. Click the number to view their scores and submit for approval. 

Rejected 

Displays the number of students in the selected course who have had their final 
grades rejected by their advisors. Click the number to view them. 

Items to Be Graded 

Displays the number of students in the selected course who have work waiting to 
be graded. Click the number to view them. 

Toolbar 

Displays various options to edit, view, and search for, and download students in 
the Gradebook. Use the toolbar to manage grade items, change how the 
Gradebook displays information, and download grade information. Depending on 
the page you are viewing, some options may be unavailable and will be grayed 
out. 

You can click the arrow next to Items to Be Graded in the upper left corner to 
expand/contract the gray bar if you need more room on the screen. 
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7.6.1. Manually Grade an Item and Leave Feedback

1. From your teacher home screen, click the Gradebook icon for a course that shows 
assignments needing grading. The system filters your Gradebook to only show 
students with gradable assignments.

2. Click an assignme

The assignment’s Attempt Details screen appears:

3. Click each number

assessment’s questions. 
allow you to enter a score:

Notice the score running total at the top of the column. As you enter or modify scores, 
the “X of Y Points” and associated percentage updates.
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Manually Grade an Item and Leave Feedback 

From your teacher home screen, click the Gradebook icon for a course that shows 
assignments needing grading. The system filters your Gradebook to only show 
students with gradable assignments. 

assignment in the Items to be Graded column: 

The assignment’s Attempt Details screen appears: 

number in the Question Score column on the left to view the 

assessment’s questions. When you click the Question Score number, it opens to 
enter a score: 

 

score running total at the top of the column. As you enter or modify scores, 
the “X of Y Points” and associated percentage updates. 
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From your teacher home screen, click the Gradebook icon for a course that shows 
assignments needing grading. The system filters your Gradebook to only show 

 

 

When you click the Question Score number, it opens to 

score running total at the top of the column. As you enter or modify scores, 
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Any questions that you need to score are marked in yellow and are labeled “_ of 
[points]”:

4. When you are finished grading the assessment, 

the Question Score list.

• 

• 

• 

7.6.1.1. Question Feedback

To leave feedback for an individual question:

1. Click the 
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Any questions that you need to score are marked in yellow and are labeled “_ of 
[points]”: 

 

When you are finished grading the assessment, click Close Attempt

the Question Score list. The Close Assessment window appears: 

 Click Complete Scoring to submit the score to Gradebook.

 Click Close without Scoring to save and close the attempt to come back to 

it later. 

 Click Cancel to close the window and return to the attempt.

Question Feedback 

To leave feedback for an individual question: 

the Feedback button for any question. A feedback window appears:
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Any questions that you need to score are marked in yellow and are labeled “_ of 

Close Attempt at the bottom of 

 

 

to submit the score to Gradebook. 

tempt to come back to 

to close the window and return to the attempt. 

appears: 
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2. Leave necessary feedback.
when finished. 

3. Any question for which you have left 
feedback will display a feedback icon. 
Mouseover the icon to quickly read the 
feedback or click the icon to edit the 
feedback. 

 
 
 

NOTE: You can 
holding down the left mouse button in the gray title bar area of the 
feedback window.

7.6.1.2. Assessment Feedback

To leave feedback for the entire assignment:

1. Click the Assessment Feedback

window appears:

2. Enter your feedback.

• Click the 

• Click Send Message

Messages inbox.

• Click the 

feedback to them.

3. You can create multiple assessment
first assessment message, the Assessment Feedback window looks like this:

4. Click an existing message to view or edit it, or click 

assessment-level feedback message.
5. The Assessment Feedback button displays the number of feedback messages you 

have created for the assessment: 
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Leave necessary feedback. Click anywhere out of the question feedback box to

Any question for which you have left 
feedback will display a feedback icon. 
Mouseover the icon to quickly read the 
feedback or click the icon to edit the 

NOTE: You can drag the question feedback box around the screen by 
holding down the left mouse button in the gray title bar area of the 
feedback window. 

Assessment Feedback 

To leave feedback for the entire assignment: 

Assessment Feedback button at the bottom of the screen. A feedback 

: 

Enter your feedback. 

Click the Attachment box to attach a file to the feedback. 

Send Message to send a copy of the feedback to the student’s 

Messages inbox. 

Click the Copy Advisor and/or Copy Parent boxes to send copies of the 

feedback to them. 

create multiple assessment feedback messages. After you have created the 
first assessment message, the Assessment Feedback window looks like this:

Click an existing message to view or edit it, or click Create to create a new 

level feedback message. 
The Assessment Feedback button displays the number of feedback messages you 
have created for the assessment:  
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anywhere out of the question feedback box to save 

drag the question feedback box around the screen by 

. A feedback 

 

to send a copy of the feedback to the student’s 

send copies of the 

feedback messages. After you have created the 
first assessment message, the Assessment Feedback window looks like this: 

 

to create a new 

The Assessment Feedback button displays the number of feedback messages you 
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7.6.1.3. Sample Answers

Sample answers are available 
about what are acceptable responses for these questions. 
for a question, 

7.6.2. View All Attempts

Students are often allowed to take assessments 
multiple times. By default,
most recent attempt on the Items to Be Graded page. 
To view previous attempts, click the 
Attempts button.

 

If the student has multiple attempts, the attempt of record (the attempt being used to 
calculate the student’s 

7.6.3. View Archived Attempts

When teachers delete
so users can see data for removed attempts.

attempt, the score (but not individual question answers) are archived and a View Archived 
Attempts button appears.

To access the archived attempt data, click the 
Archived Attempts

screen: 

Notice that the b

The Archived Attempts window appears and displays information about previous attempts:
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Sample Answers 

ample answers are available for certain questions as references to give you a 
about what are acceptable responses for these questions. If a sample answer is available 
for a question, it will appear in the body of the question. 

View All Attempts 

Students are often allowed to take assessments 
multiple times. By default, the system displays the 
most recent attempt on the Items to Be Graded page. 
To view previous attempts, click the View All 

button. 

If the student has multiple attempts, the attempt of record (the attempt being used to 
calculate the student’s grade) will have an asterisk next to its View link.

View Archived Attempts 

When teachers delete student attempts, the attempts are now archived
can see data for removed attempts. Upon clicking the Delete

attempt, the score (but not individual question answers) are archived and a View Archived 
Attempts button appears. 

To access the archived attempt data, click the View 
Archived Attempts button on the Attempt Details 

Notice that the button indicates how many attempts have been archived.

The Archived Attempts window appears and displays information about previous attempts:
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to give you a better idea 
If a sample answer is available 

 

If the student has multiple attempts, the attempt of record (the attempt being used to 
grade) will have an asterisk next to its View link. 

d instead of deleted 
Delete button for an 

attempt, the score (but not individual question answers) are archived and a View Archived 

utton indicates how many attempts have been archived. 

The Archived Attempts window appears and displays information about previous attempts: 
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7.6.4. Override an Assignment's Passed Status

You can use the Passed field on the Gradebook's Attempt Details screen to 
student to progress to the next lesson despite a low score and to force a student to retake 
an assignment already completed. This ability applies to Course Player courses.

To allow a student to pass an assignment and move to the next one, clic
located in the Pass box

To force a student to retake an assignments, click the 
then click Save. 

If a teacher manually enters a score above ma
that lesson and will now set the Passed field to Yes.

You can also edit a student's Passed status for multiple assignments:

1. From either the Items to be Graded page or Gradebook page, click a student 
username. The Student Details screen appears.

2. Click the Grades

3. Check/uncheck the Passed column for any assessments you need, 
then click the Save icon

mark/unmark all items in the column.

Click the Cancel icon

7.6.5. Exempt a Student from an Assessment

Use this feature to exempt an assignment from a student’s grade.

1. From either the Items to Be Graded or 
it. 

2. Next to Override Scor
3. Click the Exempt
4. Click Save. 

You can also edit a student's Exempt status for multiple assignments:

1. From either the Items to be Graded page or Gradebook page, click a 
username. The Student Details screen appears.
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Override an Assignment's Passed Status 

You can use the Passed field on the Gradebook's Attempt Details screen to both allow a 
student to progress to the next lesson despite a low score and to force a student to retake 
an assignment already completed. This ability applies to Course Player courses.

To allow a student to pass an assignment and move to the next one, click the Edit
located in the Pass box on the Attempt Details page and check the box, then click 

To force a student to retake an assignments, click the Edit button and uncheck the box, 

If a teacher manually enters a score above mastery for a lesson, the system still unlocks 
that lesson and will now set the Passed field to Yes. 

You can also edit a student's Passed status for multiple assignments: 

From either the Items to be Graded page or Gradebook page, click a student 
e Student Details screen appears. 

Grades tab, then click the pencil icon in the Passed column header:

Check/uncheck the Passed column for any assessments you need, 
Save icon. Click the box in the column header to 

items in the column. 

Cancel icon to close the column without saving any changes. 

Exempt a Student from an Assessment 

Use this feature to exempt an assignment from a student’s grade. 

From either the Items to Be Graded or Gradebook page, click an assessment to enter 

Override Score at the top, click Edit. 
Exempt box to mark it. 

You can also edit a student's Exempt status for multiple assignments: 

From either the Items to be Graded page or Gradebook page, click a student 
username. The Student Details screen appears. 
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both allow a 
student to progress to the next lesson despite a low score and to force a student to retake 
an assignment already completed. This ability applies to Course Player courses. 

Edit button 
and check the box, then click Save. 

button and uncheck the box, 

stery for a lesson, the system still unlocks 

From either the Items to be Graded page or Gradebook page, click a student 

in the Passed column header: 

 

assessment to enter 

student 



eSchoolware
®
 - Product User Guide for Teachers

Section: Courses 

2. Click the 

3. Check/uncheck the Exempt column for any assessments you need, 
then click the 

mark/unmark all items in the column.

Click the 

7.6.6. Override Student Grades

Use this feature to manually override the percentage generated by a system
assessment.

1. From either the Items to B
2. Next to Override Scor

3. Enter an override score.
4. Click Save

You can also exempt a student quickly from multiple assignments:

1. From either the Items to be Graded page or Gradebook page,
username. The Student Details screen appears.

2. Click the 

3. Enter a score in the Override column for any assessments you need, 
then click the 

Click the 

changes.
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Click the Grades tab, then click the pencil icon in the Exempt column header:

Check/uncheck the Exempt column for any assessments you need, 
then click the Save icon. Click the box in the column header to 

mark/unmark all items in the column. 

Click the Cancel icon to close the column without saving any changes.

Override Student Grades 

Use this feature to manually override the percentage generated by a system
assessment. 

From either the Items to Be Graded or Gradebook page, click an assessment.
Next to Override Score at the top, click Edit. 

Enter an override score. 
Save. 

You can also exempt a student quickly from multiple assignments: 

From either the Items to be Graded page or Gradebook page, click a student 
username. The Student Details screen appears. 
Click the Grades tab, then click the pencil icon in the Override column header:

Enter a score in the Override column for any assessments you need, 
then click the Save icon. 

Click the Cancel icon to close the column without saving any 

changes. 
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in the Exempt column header: 

 

Check/uncheck the Exempt column for any assessments you need, 

to close the column without saving any changes. 

Use this feature to manually override the percentage generated by a system-graded 

click an assessment. 

click a student 

in the Override column header: 

 

Enter a score in the Override column for any assessments you need, 
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7.6.7. Reset an Assessment 

From time to time, it may become necessary for a teacher to reset a student’s attempt on 
an assignment. There are multiple ways to reset an assessment. 

You must first enter the Attempt Details page for the assessment you wish to reset. 

Delete 

To delete an attempt, simply click the trash can. This deletes the attempt. Data 

cannot be recovered once deleted. 

Undo Submit 

To undo the submission of the assessment, click Undo Submit. This sends the 

assessment back to the state of “In Progress” for the student. Any work 
completed by the student prior to submission is still available. 

Clear All Attempts 

For an assessment that has multiple attempts, you can click Clear All Attempts. 

This deletes any attempts made by the student on that assessment. 

Create 

To create a new attempt where you can manually enter a score, click the Create 

button located beside Clear All Attempts in the Attempt Details screen. 

7.7. Gradebook View 

The Gradebook view provides an overview of all student work for the selected course. 

 

Note the icons in the upper right. Clicking an icon takes you to that area of the course that 
requires your attention. The icons are Items to Be Graded, Interventions, Forums, Blogs, 
Completed (ready to submit for final grade), and Rejected (final grades that have been 
rejected by advisors) meet the selected criteria: 

Also note the color coding and tabs. The various types of assessments (daily, quiz, 
writing, exam, etc.) are now color coded and can be filtered to view by clicking their 
colored tabs. 

This view contains several default data columns. You can use the Choose Fields toolbar 
item to modify the default view. 
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Approval 

Status of overall course grade for each student. 

Last-First 

Student name 

Username 

Student login name 

ID 

Unique student identifier generated by the system 

Total 

Running total for the student 

Non-Running Total 

Non-running total for the student 

7.7.1. Color Coding on Pending Items 

When a student submits an assignment that requires your attention, it will be marked 
within the Gradebook either as a red, yellow or green exclamation point (!). Each color has 
its own meaning. 

• A green exclamation point means the assignment has been submitted within 

the past 48 hours, or within the past 2 days. 

• A yellow exclamation point means the assignment was submitted 48 to 96 

hours ago, or between 2 and 4 days ago. 

• A red exclamation point means the assignment was submitted over 96 hours 

ago, or over 4 days ago. 

7.7.2. Manually Edit Grades 

1. From the toolbar, click Edit > Gradebook Entry. 

2. Click the cell of a graded item. Notice the column turns yellow and the score becomes 
an editable box: 

3. Enter your new grade and click the Save button under the toolbar. 
4. When finished, select View from the Grades icon dropdown to close editing mode. 
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7.7.3. Manage Gradebook

This feature lets you edit, create, and delete 

From the toolbar, click 

Back 

Click to return to the main Gradebook screen.

Grading Period

Select a period

Position 

Order in which the item appears on the main screen. The higher the number, the 
further to the right it appears.

Name 

Name of item

Due Date 

Date item is to be completed

Type 

Assignment, Essay, Exam, Homework

Points 

Number of points the item is worth

Display As 

Percentage, Letter, Score

Multiple Attempt Policy

Determines how to handle multiple assignment attempts: 
Lowest, First, or Average Attempt

Visible 

Is item visible on grading list?
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Manage Gradebook Items 

This feature lets you edit, create, and delete gradable items for a course. 

lick Edit > Gradebook Items. 

Click to return to the main Gradebook screen. 

Grading Period 

period to filter the items 

Order in which the item appears on the main screen. The higher the number, the 
further to the right it appears. 

Name of item 

Date item is to be completed 

Assignment, Essay, Exam, Homework 

Number of points the item is worth 

Percentage, Letter, Score 

Multiple Attempt Policy 

Determines how to handle multiple assignment attempts: Recent, Highest, 
west, First, or Average Attempt 

Is item visible on grading list? 

All rights reserved. 
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Order in which the item appears on the main screen. The higher the number, the 

Recent, Highest, 
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Scorable 

Is item calculated toward final grade? 

Require 

Is item required to be completed? 

Grading Period 

What period the item is in 

Delete 

Click the icon to delete. If the icon has a circle and slash on it, the item cannot be 
deleted. 

Add 

Click to add a new gradable item 

Edit 

Click to edit existing items 

NOTE: The Scorable setting for a Gradebook item only controls 
whether the item is used in calculating the overall course grade; 
it has no effect on how the overall course progress is calculated. 
If a Gradebook item is set to Require=no, it is omitted in 
calculating overall course progress. 

7.7.3.1. Add a Gradable Item 

1. Click Add. A new line appears at the bottom of the list. 

2. Complete the fields: 

 

3. Click Save. Your new item appears at the bottom of the list. 

7.7.3.2. Edit a Gradable Item 

1. Click the Edit button. Item fields become editable: 

2. Make your changes. 
3. To delete an item, click the Delete icon on the far right. 
4. Click Save. 
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7.7.4. Manage Grade Display Levels 

Click Item to access Manage Items. This feature lets you edit, create, and delete settings 
for how grades display. From the toolbar, click Edit > Display Levels. 

 

Back 

Click to return to the previous page 

Create 

Click to create a new display setting 

Previous/Back 

Click to navigate through a large list of items 

Page 

Click to navigate through a large list of items 

Rows per Page 

Enter the number of data rows to display on each page viewed 

Title 

Name of item 

User Defined 

Is the item configured by the user or by the system? 

Copy 

Click to copy the line 

Edit 

Click to edit the line 

Delete 

Click to delete the line 

Click the plus sign next to an item to view its grade level details: 
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7.7.4.1. Create a New Grade Display Level 

1. Click Create. A new line appears: 

 

2. Enter the item name and click Save. Your new item appears in the list: 

 

3. Click the plus sign next to the name. Threshold criteria display: 

 

4. Enter threshold percent values on the left. 
5. Enter text that each level displays for the grade in the Display As field. 
6. Click the Add icon to add a new line for another threshold level: 

 

7. Click the Remove icon to remove a level. 
8. Click Submit to create the list for the item. 

7.7.4.2. Edit a Grade Display Level 

To edit a Grade Display Level title: 

1. Click the Edit icon for that item. 

2. Enter a new name in the Title field. 
3. Click Save. 

To edit grade levels: 

1. Click the plus sign beside the Display Level title. 

2. Make changes per the instructions above on creating thresholds. 
3. Click Save. 

7.7.4.3. Delete a Grade Display Level 

1. Click the Delete icon. 
2. Click OK when prompted if you are sure. 
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7.7.5. Weigh Items 

From the toolbar, click 

Items or categories in a course can be given unique weighting to be calculated in the final 
weighted grade for the course. For example, a final exam might be worth 30% of the 
grade, while assignments might each be worth 10%. Weights can 
and the grades will be recalculated accordingly.
included in the grade calculations.

• Only items attempted by the student are calculated in the weighted grade. 
Weighted grades are calculated by
item. 

• Items marked with a dash (
in the grade calculations.

• Weighted percentages must add up to 100%. An error message is displayed 
if they do not.

• New items are assi
not calculated in the weighted grade.

7.7.5.1. Weight by Item

When using item weighting

1. The weighted percent of each item is multiplied by the number of p
divided by the number of points possible for the item. 

2. Add the weighted scores together.
3. Add the total weighted percents of the 
4. Divide the total weighted percentage score by the total

attempted items and multiply by 100.
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From the toolbar, click Edit > Weigh Items. 

Items or categories in a course can be given unique weighting to be calculated in the final 
weighted grade for the course. For example, a final exam might be worth 30% of the 

ssignments might each be worth 10%. Weights can be modified at any time 
and the grades will be recalculated accordingly. Items with zero possible points are not 
included in the grade calculations. 

Only items attempted by the student are calculated in the weighted grade. 
Weighted grades are calculated by including the score of the last attempted 

Items marked with a dash (-) have not been attempted and are not included 
in the grade calculations. 

Weighted percentages must add up to 100%. An error message is displayed 
if they do not. 

New items are assigned a default weight of 0%. Items weighted at 0% are 
not calculated in the weighted grade. 

Weight by Item 

item weighting, the weighted cumulative score is calculated as follows

The weighted percent of each item is multiplied by the number of points achieved, 
divided by the number of points possible for the item.  
Add the weighted scores together. 

weighted percents of the attempted assignments together. 
Divide the total weighted percentage score by the total weighted percents of the 

items and multiply by 100. 
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Items or categories in a course can be given unique weighting to be calculated in the final 
weighted grade for the course. For example, a final exam might be worth 30% of the final 

be modified at any time 
Items with zero possible points are not 

Only items attempted by the student are calculated in the weighted grade. 
including the score of the last attempted 

) have not been attempted and are not included 

Weighted percentages must add up to 100%. An error message is displayed 

gned a default weight of 0%. Items weighted at 0% are 

, the weighted cumulative score is calculated as follows: 

oints achieved, 

weighted percents of the 
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For example, here are detailed calculations for a student: 

Step 1: 

• Item 1: Addition 
0.15 x (4/5) = .12 

• Item 2: Test 1 
0.15 x (24/30) = .12 

• Item 3: Homework 1: 
0.08 x (3/5) = .048 

• Items 4 through 7 (Homework2–Homework5) are excluded from the 
calculation because they have not yet been attempted by the student. 

• Item 8: Subtract 
0.15 x (5/5) = .15 

• Item 9 (Addition) is excluded from the calculation because it has not yet 
been attempted by the student. 

Step 2: 

• Add all the weighted percentages together. 
.12 +.12 +.048 +.15 = 0.438 

Step 3: 

• Add the weighted percentages of the attempted items. 
.15 +.15 +.08 +.15 = 0.53 

Step 4: 

• Divide the total weighted percentage score by the total weighted percents of 
the attempted items and multiply by 100. 

• (0.438/0.53) x 100 = 82.6%, the final weighted percentage score 

7.7.5.2. Weight by Category 

When weighting by category, each graded item is part of a category that carries a 
weighted percentage of the total grade. 

To calculate the student’s weighted grade: 

1. Add the total points achieved for each category and, separately, add the total points 
attempted for each category.  

2. Within each category, divide the total points achieved by the total points attempted.  
That total is then multiplied by the weighted percent for the category.   This is your 
weighted average. 

3. Add the weighted averages together. 
4.  Divide the total weighted averages by the total weighted percents of the attempted 

categories and multiply by 100. 
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For example, here are the detailed calculations for a student: 

Steps 1 and 2: 

• Find the total points achieved and total points possible for each category. 

• The Assignments category contains the items named Homework1, 
Homework 2, Homework 3, Homework 4, and Homework 5. Homework 
2 through Homework 5 are not included because they have not yet been 
attempted by the student.  

• Total points attempted in the category: 5 

• Total points achieved: 3 

• Category weight: 40% 

• Weighted average for this category: 0.4 x (3/5) = .24 

• The Exam category contains the items named Addition Test, Test 1, 
Subtraction Test, and a second Addition Test. The second Addition Test 
is not included because it has not yet been attempted by the student. 

• Total points possible in the category: 40 

• Total points achieved: 33 

• Category weight: 60% 

• Weighted average for this category: 0.6 x (33/40) = .495 

Step 3: 

• Add all the weighted averages together. 
.24 +.495 = 0.735 

Step 4: 

• Divide the total weighted average by the total weighted percents of the 
attempted categories and multiply by 100: 
[.735/(0.4 + 0.6)] x 100 = 73.5%, the final weighted percentage score. 

Notice that same scores result in a different grade when weighted by category rather than 
by item. 

7.7.5.3. Weight by Point 

When weighting by point, each graded item has equal weight. 

To calculate the student’s weighted grade: 

1. Add the total points achieved for all items.  
2. Add the total points attempted for all items.  
3. Divide the total points achieved by the total points attempted. 
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For example, here are the detailed calculations for 

Step 1: 

• 

Step 2: 

• 

Step 3: 

• 

• 

Notice that same scores result in a different grade when weighted by point rather than by 
item or category.

After you have made any weighting changes, click the 

based on the new

7.7.6. Manage Assignment Dues Dates

Complete the steps below to add a due date to an assignment.

1. Click the name of the assignment 

2. The following screen appears. Enter a due date into the Due Date field t
Save. 

NOTE
for that assignment. Any student who does not submit the assignment 
before the due date will have a superscripted L next to their score. If you 
remove the due date in 
assignment will continue to do so in the Gradebook. A late assignment 
does not affect the student’s grade; it is only an indicator to you as the 
teacher that the student submitted it late and you can act acc
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For example, here are the detailed calculations for a student: 

 Add the points achieved for all items together. 
4 + 24 + 3 + 5 = 36 

 Add the points attempted for all items together. 
5 + 30 + 5 + 5 = 45 

 Divide the total points achieved by the total points attempted.

 36 / 45 = 80 

Notice that same scores result in a different grade when weighted by point rather than by 
item or category. 

you have made any weighting changes, click the Update button to update the grade 

based on the new calculations. 

Manage Assignment Dues Dates 

Complete the steps below to add a due date to an assignment. 

lick the name of the assignment for which you would like to add a due date:

The following screen appears. Enter a due date into the Due Date field t

NOTE: If you add a due date, that date is entered into the Gradebook 
for that assignment. Any student who does not submit the assignment 
before the due date will have a superscripted L next to their score. If you 
remove the due date in the future, any students who had an L for a late 
assignment will continue to do so in the Gradebook. A late assignment 
does not affect the student’s grade; it is only an indicator to you as the 
teacher that the student submitted it late and you can act acc
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by the total points attempted. 

Notice that same scores result in a different grade when weighted by point rather than by 

button to update the grade 

would like to add a due date: 

 

The following screen appears. Enter a due date into the Due Date field then click 

 

: If you add a due date, that date is entered into the Gradebook 
for that assignment. Any student who does not submit the assignment 
before the due date will have a superscripted L next to their score. If you 

the future, any students who had an L for a late 
assignment will continue to do so in the Gradebook. A late assignment 
does not affect the student’s grade; it is only an indicator to you as the 
teacher that the student submitted it late and you can act accordingly. 
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7.7.7. Lock an Assignment

1. Click the name of the assignment 

2. The following screen appears. Click the Locked Status dropdown and select 
then click Save. 

You can also lock/unlock assessments for individual 
screen. 

7.7.8. Modify Other 

Click any underlined column title to modify that item’s properties. Modifying a grade item is 
especially helpful when working with special education students who need 
accommodations due to
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an Assignment 

lick the name of the assignment for which you would like to lock: 

 

The following screen appears. Click the Locked Status dropdown and select 
 

You can also lock/unlock assessments for individual students via the Attempt Details 

Other Grade Items 

Click any underlined column title to modify that item’s properties. Modifying a grade item is 
especially helpful when working with special education students who need 

due to an IEP or a 504 plan. 
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The following screen appears. Click the Locked Status dropdown and select Lock, 

 

students via the Attempt Details 

 

Click any underlined column title to modify that item’s properties. Modifying a grade item is 
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Name 

Name of assignment 

Type 

• Assignment 

• Essay 

• Exam 

• Homework 

Due Date 

Date assignment is to be completed 

Points Possible 

Maximum score possible 

Display As 

Select a grade display option 

More...  See the Manage Grade Display Levels section above for more information about the 
choices in this field. 

Multiple Attempt Policy 

Determines how to handle multiple assignment attempts: Recent, Highest, 
Lowest, First, or Average Attempt 

Visible 

Is item visible to students? 

Scorable 

Is item calculated toward final grade? 

Require 

Is student required to complete the item? 

Grading Period 

Grading period in which the assignment falls 

Locked Status 

Is assignment locked to prevent students from doing it? 

NOTE: The Scorable setting for a Gradebook item only controls whether 
the item is used in calculating the overall course grade; it has no effect 
on how the overall course progress is calculated. If a Gradebook item is 
set to Require=no, it is omitted in calculating overall course progress. 

Click Save to apply any changes. Click Back to return to the previous screen. 

Notice that if an item is set to not scorable, not visible to 
students, and/or locked for access, icons appear for 
those conditions in the column header: 
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7.7.9. Filter Students by Approval Status 

Throughout the school year, students will progress within your course. You can use filters 
to view where each student stands within your course from a general standpoint. At all 
times, students within your course will be in one of the following stages: 

• Requestable – The student is actively working within your course. 

• Pending – You have approved the student’s grade and it is pending review 

by that student’s advisor. 

• Approved – You have approved the student’s grade and it has also been 

approved by that student’s advisor. 

• Rejected – You have approved the student’s grade and it was rejected by 

the advisor. At this point, the advisor should send a comment along with the 
rejection stating why the student’s grade was rejected or any actions that 
may need to be taken for that student, such as resetting assignments. 

To filter your students by status, click Filter in the toolbar and make the appropriate 

selection in the Approval column. 

7.7.10. Filter Students by Activity Status 

Click the Users icon to filter by active/inactive status. 

To filter your students by status, click Filter in the toolbar and make the appropriate 

selection in the Users column. 

7.7.11. Search 

Click the Search link and select first name, last name, or username to search by. 

7.7.12. Choose Fields to View 

Click the Choose Fields link to filter by available data columns. Place checkmarks next to 

those columns you wish to view. 

7.7.13. Approve Final Grades 

When a student has completed all work in a course, you must approve their final grade in 
Gradebook in order for them to receive credit. In addition to just approving the system-
generated grade, you may also override or clear grades. Examples of when you may need 
to do this include taking into account additional components to the course not included in 
the system or special exceptions due to a student’s life circumstance as approved by your 
admin. You may also clear an assessment if a student submitted an assignment in error. 
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The Approval column displays the 
grade status for the entire course. 
Course grades fall into four categories: 

 Requestable – Grade is available to 
be submitted for approval. Click the 
icon to view the approval box:  

Select the type of grade, enter any 
comments, and click Submit. Click the 
X to close the window. 

 

Depending on your school's configuration, you may also have the option to assign a 
percent value for all assessments not completed by the student, so that unfinished work is 
correctly reflected in the student's final grade for the course. Mark the Apply All 
Unfinished Assessments button and enter a percent value. 

 Pending – Grade is pending approval by 
advisor. Click the icon to view the approval box:  

Click Delete Request to cancel the approval 
request. Click the X to close the box. 

 

 Approved – Grade was approved by advisor. 
Click the icon to view the approval box: 

Click Delete to change the grade status from 
Approved back to Requestable. Click the X to close 

the window. 

 

 

 

 

 Rejected – Grade was rejected by advisor. Click 
the icon to view the approval box: 

Information about the rejection appears in the top half 
of the window. You can resubmit the grade with 
comments in the bottom half. Select the type of 
grade, enter any comments, and click Submit. Click 
the X to close the box. 
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7.8. Student Details 

Click a student name in either the Items to Be Graded or Gradebook screen to view 
detailed information about that student. 

 

7.8.1. Information Bar 

The gray bar at the top of the page contains commonly used information about the 
student. Click the information bubble next to the student’s name to expand/contract the 

bar: 

 

Click the message icon next to the student’s name to message them. Note that you can 

CC advisors and/or parents via checkboxes when creating messages to students You can 
also send a copy of the message to the student’s Notes area for future reference by you 
or the student’s advisor(s). 

Click the message icon next to the advisor’s name to message the student’s advisor(s). 
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7.8.2. Grades Tab

The Grade tab provides details about the student’s course you wer
clicked the student’s name.

The top of the Grade tab contains information about the course, as well as overall student 
grade information for the course.

• 

• 

• 

The grade table displays information about 
several fields 
Clicking a pencil opens the column to edit and makes Save and Cancel icons appear.

• 

• 

• 

• 

7.8.2.1. View Diagnostic Assessment Results

Teachers can view di
Gradebook. If a diagnostic exists for a student, an icon appears to the right of the course 
name in the Student Details > Grades tab. Click the icon to view the student’s diagnostic 
results. 
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Grades Tab 

The Grade tab provides details about the student’s course you were viewing when you 
clicked the student’s name. 

The top of the Grade tab contains information about the course, as well as overall student 
grade information for the course. 

 Click the approval icon next to the Grade field to approve the final course 

grade. 

 Click the printer or Excel icons to either print or download the grade table.

 Click the Percent value to view that assignment’s Attempt Details screen.

The grade table displays information about all assignments in the course. You can edit 
everal fields to change their status. These columns have pencil icons in their headers. 

Clicking a pencil opens the column to edit and makes Save and Cancel icons appear.

 Override – Click the pencil icon to enter override grades for assignments.

 Exempt – Click the pencil icon to exempt a student from any assignment(s).

 Passed – Click the pencil icon to change an assignment’s Passed status.

 Clear – Click the pencil icon to clear all attempts for selected assignments.

View Diagnostic Assessment Results 

Teachers can view diagnostic results from the Student Details view available through the 
Gradebook. If a diagnostic exists for a student, an icon appears to the right of the course 
name in the Student Details > Grades tab. Click the icon to view the student’s diagnostic 
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e viewing when you 

 

The top of the Grade tab contains information about the course, as well as overall student 

next to the Grade field to approve the final course 

icons to either print or download the grade table. 

value to view that assignment’s Attempt Details screen. 

all assignments in the course. You can edit 
These columns have pencil icons in their headers. 

Clicking a pencil opens the column to edit and makes Save and Cancel icons appear. 

to enter override grades for assignments. 

to exempt a student from any assignment(s). 

to change an assignment’s Passed status. 

to clear all attempts for selected assignments. 

agnostic results from the Student Details view available through the 
Gradebook. If a diagnostic exists for a student, an icon appears to the right of the course 
name in the Student Details > Grades tab. Click the icon to view the student’s diagnostic 
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7.8.3. Family Info Tab 

This tab displays contact information for the student. 

 

Any primary or alternate contact that has an eSchoolware login can be messaged by 
clicking the envelope icon by their contact header. 

You can print the Family Info tab by clicking the print icon in the upper right corner of the 

screen. 

NOTE: These are read-only fields; only advisors can edit this 
information. 

7.8.4. Notes Tab 

Use the Notes tab to create and store incidental information about your students. You 
have the option of sharing notes with other teachers and advisors assigned to the student. 

1. From either the Items to Be Graded or Gradebook page, click a student username. 
The Student Details screen appears. 

2. Click the Notes tab. 
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7.8.4.1. 127Create a New Note 

1. Click the orange Create a Note button at the right of the screen. The Create a Note 

window appears: 

 

 

NOTE: In the interest of student privacy, the system default setting for 
notes is Private. Consult your school’s policies for details about when to 
use Private or Communal. 

Subject 

Enter subject of note 

Content 

Enter note information here. This field has a 3999 character maximum. 

Note Type 

Select a category in which the note fits. You can use this information to filter 
notes when viewing them. This list will vary depending on your school’s 
configuration. 

Note Privacy 

• Select Private to allow only you to view, edit, and delete the note. 

• Select Communal to allow all teachers and advisors assigned to the student 

to view the note. These other users may not edit or delete it. 

NOTE: Advisor administrators and institutional administrators can view 
all notes, communal or private, in their respective institutions. 
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Attach a File 

Click to select a file to attach to the note.

Click Browse to find and select a file, then click the orange checkmark
to the note. 

2. Click the Create 

fields without saving or creating.

The new note is now part of the list.

Once you create a note, you can change it by clicking its 
by clicking its Delete Note

delete it. 

Click a note’s title header to expand or contract its contents. You can also use Display 
Settings > Expanded/Contracted to expand and

7.8.4.2. Filter and Search Notes

Use the search and filter settings on the right to limit what notes appear in the list.

Display Settings

Use these settings to display 
contents of notes.

Privacy 

Filter notes by privacy 

Type 

Filter notes by type. This 
depending on your school’s configuration.

Search 

Click the dropdown 
date, subject, content, or creator. A text box 
appears to enter search text or, if calendar is 
selected, a calendar con
Search button to conduct your search.

7.8.4.3. Saving Messages to Notes

Teachers and advisors 
sending a message to a student
associated with them, to have that message sen
to the student’s Notes page
that you can more easily record a history of your 
communication with the student
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Click to select a file to attach to the note. 

Click Browse to find and select a file, then click the orange checkmark
 

 on the note’s line to publish the note; click Cancel to close these 

fields without saving or creating. 

The new note is now part of the list. 

Once you create a note, you can change it by clicking its Edit Note icon. You can delete it 
Delete Note icon. If you are not the creator of a note, you cannot edit or 

a note’s title header to expand or contract its contents. You can also use Display 
Settings > Expanded/Contracted to expand and contract all notes. 

Filter and Search Notes 

Use the search and filter settings on the right to limit what notes appear in the list.

Settings 

Use these settings to display or hide the 
contents of notes. 

Filter notes by privacy settings. 

Filter notes by type. This list will vary 
depending on your school’s configuration. 

Click the dropdown search by note creation 
date, subject, content, or creator. A text box 
appears to enter search text or, if calendar is 
selected, a calendar control. Click the orange 
Search button to conduct your search. 

Saving Messages to Notes 

Teachers and advisors have the option when 
sending a message to a student or staff members 

, to have that message sent 
to the student’s Notes page as an attached file so 

easily record a history of your 
communication with the student. 
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Click Browse to find and select a file, then click the orange checkmark to attach it 

to close these 

n. You can delete it 
icon. If you are not the creator of a note, you cannot edit or 

a note’s title header to expand or contract its contents. You can also use Display 

Use the search and filter settings on the right to limit what notes appear in the list. 
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When creating a message, mark the 

subject line: 

On the Notes page, a note created this way has Message 
its header: 

 

The subject of the message is the subject of the note:

The content of the message is stored as an attachment to the note:

Any file attachments you included in the original message are also stored in the note as 
attachments, as well.

7.8.5. Restrictions Tab

This tab is used to place a restriction on further progress in a course for a student. 
student has a restriction in place, they are no longer able to move forward in that course. 
Traditional legacy and Course Player

• 

• 

• 
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When creating a message, mark the Send to Student Notes box located beneath the 

 

On the Notes page, a note created this way has Message in 

The subject of the message is the subject of the note: 

The content of the message is stored as an attachment to the note: 

Any file attachments you included in the original message are also stored in the note as 
attachments, as well. 

trictions Tab 

This tab is used to place a restriction on further progress in a course for a student. 
student has a restriction in place, they are no longer able to move forward in that course. 
Traditional legacy and Course Player courses can have restrictions placed on them.

 Click Create to place a restriction on the course for the selected student.

 Click the Restriction Details icon to view information about it.

 Click Remove to remove a restriction. Removed restrictions remain in the 

list and display who removed them and when. 
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box located beneath the 

 

 

Any file attachments you included in the original message are also stored in the note as 

This tab is used to place a restriction on further progress in a course for a student. Once a 
student has a restriction in place, they are no longer able to move forward in that course. 

strictions placed on them. 

 

to place a restriction on the course for the selected student. 

icon to view information about it. 

to remove a restriction. Removed restrictions remain in the 
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7.9. Intervention 

Interventions are additional remedial work given to a student when they fail a performance 
standard. Any time a student fails a performance standard, an intervention is created 
either by the teacher or automatically by the system. Interventions are the vehicle for 
targeted remediation in your eCourses. Here you can identify student weaknesses, target 
standards where groups of students are struggling, and help students access resources 
that present the material in a different way. Interventions provide the data needed so that 
you can individualize your instruction for students who are struggling to master the 
concepts in your course. 

The system’s intervention strategy enables early identification and intervention for 
students at academic risk: 

Tier 1 

Communication with the Personal Learning Plan (PLP) team, lead by the 
Advisor, states that curriculum intervention tasks have been assigned using the 
Performance Alerts system. Intervention tasks may include, but are not limited to, 
re-teaching activities, on-demand videos, podcasts, prescriptive software 
programs, relevant web links, supplemental worksheets and other educational 
tools. 

Tier 2 

Automatically generated tutoring sessions. This could be assigned as group 
tutoring or private tutoring and is designed to address the specific concept where 
the weakness has been identified. This information will also be communicated to 
the Advisor. 

Tier 3 

Action Plan for Intervention that prescribes a complete program to ensure 
student success. This could also include a possible behavioral assessment or a 
referral to the SAP (Student Assistance Program) team. 
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To access this feature: 

1. Log in to the eSchoolware software. Use a web browser to navigate to the server. 
Your support person can tell you the correct Internet address if you do not know it. 

2. Once there, enter your user name and password, then click Sign In. Your teacher 

home page appears. 
3. Click the Interventions icon for a course in My Courses. The number in the blue box 

represents the amount of items for that class that require tasks. Click the button to 
view them: 
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Back 

Click to return to the previous screen. 

Filter bar 

Use the dropdown fields to filter your student list. Use the Course Section 
dropdown to switch to another section of the course, if you have multiple 
sections. Click Go to view your filtered results. 

Username 

Login of student for the system 

First Name 

First name of each student 

Last Name 

Last name of each student 

Intervention Count 

Number of pending interventions for each student 

Click any item in a student row to view that student’s interventions. The following screen 
appears: 

 

Back 

Click to return to the previous screen. 

Indicator 

Name of performance indicator 

Value 

Brief description of indicator 

Intervention Level 

Specifies if this is the first, second, or third alert related to this particular indicator 

Proficiency Level 

Level of student performance: 

• Advanced 

• Proficient 

• Basic 

• Below Basic 
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Completed Date 

Date when student completed interventions tasks 

Details 

Click the icon to view detailed intervention information. 

Click the Details icon to view the Performance Summary for a student’s course 

interventions. The following screen appears. 

7.9.1. Performance Summary 

Click the Details icon to view the Performance Summary for a student’s course 

interventions. The following screen appears. 

 

Back 

Click to return to the previous screen. 

Indicator 

Name of performance indicator 

Value 

Brief description of indicator 

Intervention Level 

Specifies if this is the first, second, or third alert related to this particular indicator 

Proficiency Level 

Level of student performance: 

• Advanced 

• Proficient 

• Basic 

• Below Basic 

Completed Date 

Date when student completed interventions tasks 

Details 

Click the icon to view detailed intervention information. 
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7.9.1.1. Performance Summary Details 

Interventions are additional remedial work given to a student when they fail a performance 
standard. Any time a student fails a performance standard, an intervention is created 
either by the teacher or automatically by the system. Interventions for each standard are 
labeled 1, 2, or 3, depending on the number of times the student has failed the standard. 

From the screen above, click the Details icon to view intervention details. The following 

screen appears: 

 

7.9.1.1.1. Intervention Info Bar 

 

Number of Failed Questions 

How many questions the student failed 

Total Number of Questions 

Number of questions on the failed assessment 

Proficiency Level 

Level of student performance: 

• Advanced 

• Proficient 

• Basic 

• Below Basic 

Percentage 

Percent of the number of correct answers out of the number of total items 
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7.9.1.1.2. Assessment 

The Assessment field displays scoring information on failed assessments. 

 

Assessment Name 

Name of the failed assessment 

Attempt Date 

Date assessment was completed by student 

Ratio 

Ratio of incorrect to total questions 

Attempt Score 

Number of correct points 

Click an assessment name to view more information about it: 

 

Question ID 

Unique identifier of question 

Possible Points 

Number of points possible for correctly answering that question 

Value 

Number of points actually earned by the student 

Pass/Fail 

Denotes whether the student passed the question based on grading criteria 
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7.9.1.1.3. Additional Assessment 

If a student fails several assessments tied to the same standard before a teacher or 
advisor has a chance to create an intervention for the first one, the additional related 
assessments are listed in the Additional Assessment box. When creating an intervention, 
you can see and take into account all of the related assessments at once. 

 

Assessment Name 

Name of the failed assessment 

Attempt Date 

Date assessment was completed by student 

Ratio 

Ratio of incorrect to total questions 

Score 

Number of correct points 

Percentage 

Displays what the total intervention score (score at top of screen in the info bar) 
would be if the assessment is moved and counted in the Assessment box 

Add 

Click to move the attempt from the Additional Assessment box to the 
Assessment box. Doing this can raise the student’s score, allows intervention 
tasks to be created for the additional failed assessments, and allows multiple 
assessments tied to the same indicators to be cleared. 

7.9.1.1.4. Intervention Task 

 

Create 

Click to create a new intervention for the student 
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Type 

• E – External Link 

• R – Resource 

• L – Learning Package 

Created Time 

When intervention was created 

Completed Time 

When intervention was completed by student 

Remove 

Click icon to remove intervention task 

7.9.1.2. Create a New Intervention 

1. Click the Create button. The following screen appears: 

 

2. Select the intervention type: 

• Learning Package - a premade lesson 

• External Link - an Internet resource 

• Resource - other tools stored on the system 

Learning Package 

 

Select the appropriate item from the 
course’s learning package and click Create. 

From any lesson, you can select any of the 
pages or items in the lesson’s toolbar: 

 

 

 



eSchoolware
®
 - Product User Guide for Teachers  © 2014 EdisonLearning, Inc. All rights reserved. 

Section: Courses Page 72 

External Link 

 

• Name Field – Enter a name for the link 

• Description – Enter a description for the link 

• External Link – Enter the URL for the link 

Click Create when finished. 

Resource 

Click the Select icon to choose a resource from the list. 

Your student’s new intervention task appears in the list. 
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8. Foundation and MyDay 
Courses 

There are a couple differences to note when working with Foundation and MyDay courses 
as opposed to legacy courses. These are described below. 

8.1. Blogs 

There are no blogs associated with Foundation or MyDay courses. 

8.2. Availability for Online Tutoring 

When you are logged into Research Center or Learning Land, you appear as available for 
tutoring to students through their course player Quick Nav Menu: 

From the Quick Nav menu of a Foundation or MyDay course, a student clicks the Tutor 

button. A list of teachers who are currently logged in and available to tutor appears: 

 

The student clicks your name to send a message to you: 

A student enters a message in the bottom 
blue box and presses <Enter> to send it. A 
similar window appears on your screen. 

Click the blue Close button to exit the 

messaging window. 

Click the red Invite to Whiteboard button 

to invite the student to a whiteboard 
session. The student will receive a window 
to accept the invitation to join. The student 
can also invite you from their messaging 
window. 
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When either you or the student accepts, you will both be in a whiteboard session together. 
As tutor, you are the owner of the session.

8.3. Find Student Assignments

Complete the steps below to find a Foundation 

1. From your teacher home page, click 
a course section’s 

 

 

 

2. A new browser tab opens, containing a course preview. 
Click the Menu tab on the left, then click the 

icon: 

 

 

 

3. A list of the course’s assignments 

4. Click an assignment’s 

NOTE: The teacher view does not see assignments indexed in order as students 
do. 
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When either you or the student accepts, you will both be in a whiteboard session together. 
As tutor, you are the owner of the session. 

Find Student Assignments 

steps below to find a Foundation or MyDay course’s list of assignments.

From your teacher home page, click 
course section’s preview icon:  

A new browser tab opens, containing a course preview. 
tab on the left, then click the Assignments 

A list of the course’s assignments appears: 

Click an assignment’s Enter button to preview it. 

NOTE: The teacher view does not see assignments indexed in order as students 
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When either you or the student accepts, you will both be in a whiteboard session together. 

list of assignments. 

 

NOTE: The teacher view does not see assignments indexed in order as students 
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9. Custom Reports 

There are a number of reports that may be available to you, such as basic student contact 
information, course rosters, tracking student progress within courses, and more. Custom 
reports can be accessed by clicking the Control Panel > Custom Reports > [select a 
school] > [select the report and enter any parameters required for the report]. Then, 

select how you would like to view the generated report. 
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10. Appendix A: Essential Tasks 

This appendix contains abbreviated instructions for completing the most common teacher 
tasks. For more detailed information, please refer to the preceding sections of the user 
guide. 

Manually Grade Student Work 

1. From your teacher home screen, click a course to expand it, then click the Items to 
Be Graded icon for a section. 

2. Click an assignment in the Items to be Graded column. 
3. Assign numeric grades in the column under Score, then click Save. 
4. Click Feedback. 

5. Leave necessary feedback (see below). 
6. Click Save Feedback. 

7. Close assignment window using the red X at the top right of the window. 

Leave Feedback on Assignments 

To leave feedback for an entire assignment: 

1. Select a student assessment to grade. 
2. In the Attempt Details screen, click the Assessment Feedback button in the bottom 

right corner. 
3. Enter your feedback message, then click the Create button. 

To leave feedback for individual questions: 

1. In the Attempt Details screen, click the Feedback button for a question to leave 

feedback for it. 
2. Enter and format your feedback for the question, then click anywhere out of the 

Feedback window. 

Exempt an Item from Grading 

1. From the Attempt Details screen, next to Override Grade, click Edit. 
2. Click Exempt box to insert checkmark. 
3. Click Save. 

Add an Item to the Gradebook and Assign a Grade 

1. From the Gradebook toolbar, click Edit > Gradebook Items. The Manage Items 

screen appears. 
2. Click Add in the upper-right corner of the screen. A new line appears at the bottom of 

the list of gradable items. 
3. Complete the fields. 
4. Click Save. Your new item appears at the bottom of the list. 
5. Click Back to return to the Gradebook. Your item appears at the far right of the list. 
6. Click the Grades icon dropdown and select Edit. 

7. Click the cell of a graded item. Notice the column turns yellow and the score becomes 
an editable box. 

8. Enter your new grade and click the Save button. 
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Approve Grades 

1. From your teacher home screen, click a course to expand it, then click the 
Completed Students icon for a section. 

2. Click the Requestable icon in the Approval column for a student, select the grade 
value to use, add any comments, and click Submit. 

3. To cancel an approval request, click an item with a Pending icon in the Approval 
column, and click Delete Request. 

View and Create Interventions 

On your teacher home screen, the Intervention icons display the pending interventions of 
students assigned to you for each course and section. 

1. Click a section Intervention icon. 
2. Click any item in a student row to view that student’s interventions. 
3. Click the Details icon to view detailed intervention information on the Performance 

Summary screen. 
4. In the Intervention Task box, click Create. 

5. Select the intervention type and enter any required information. 
6. Click Create. 

View and Create Forums 

1. From your teacher home screen, click a course to expand it, then click a section’s 
Course Control Panel icon. 

2. Click the Forums tab. 
3. Click the Create Forums button to create a new forum for the course. 
4. Click the Order Number dropdown to select the order in which the forum should 

appear. 
5. Click Ratings to view student ratings of the forum. 
6. Click Blocked Users to view, add, and remove students who are blocked from the 

forum. 
7. Click Edit to edit the forum description and moderation status. 
8. Click Delete to delete the forum. 

View and Create Course Announcements 

1. From your teacher home screen, click a course to expand it, then click a section’s 
Course Control Panel icon. 

2. Click the Announcements tab. The main announcement screen for the course 

appears. 
3. Click the Create button in the upper right to create a new announcement. 

4. Enter and format your text, set the display timeframe (if applicable), select the 
appropriate section(s), and add any attachments. 

5. Click the Create button at the bottom of the screen. 
6. From the main announcement screen, click the Edit button to modify an existing 

announcement. 
7. From the main announcement screen, click the Delete button to remove an existing 

announcement. 
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11. Appendix B: Using Research 
Center and Learning Land for 
Tutoring 

 

11.1. Basic Features 

Complete the steps below to use the Research Center for tutoring. 

1. Log in to the system. If you have multiple roles, be sure you select Teacher from the 

Home icon dropdown. 
2. Click the Research Center or Learning Land icon in the Other Information box: 

 

3. Research Center or Learning Land opens and places you in the Agora: 
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The entire Research Center looks like this: 

 

Learning Land looks like this: 

 

4. From here ,you can manually 
walk around to each area of 
the Research Center by 
clicking a building, or you can 
click the globe at the top left: 
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1. When you click the globe, a screen appears to select a Research Center area. For tutoring, select 
the Learning Lab. 

 

5. Once in the Learning Lab, you can click on any of the four tables to begin a 
whiteboard session: 
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The blue buttons in the upper left are used throughout the Research Center: 

Button Function 

 

Click the arrows for navigating the profiles of other users logged into the 

Research Center. 

 

Click the home button to return to your own profile. 

 

Click the globe to view a map of the Research Center and select another 

area to go to. 

 

Click the envelope to read any Research Center notifications. 

 

Click the question mark to view online help. 

 

Click the play button to return to the Course Player. 

 

Click the friends button to view a list of your friends who are currently in 

the Research Center. 

 

Click the alert light to turn on/off an audible alert when a student enters 

the Learning Lab. 
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6. After clicking a table, a whiteboard session appears: 

 

 

You have several tools available to manage and use the whiteboard: 

Button Function 

 

When you create a whiteboard session, you automatically become the owner of that 
session. You must grant students access to join and to write on the whiteboard while you 
are the owner. Use the Grant Rights button to do this. 

 

Use the Remove Rights button to revoke rights you have given to students. 

 

Click the Clear Panel button to clear the whiteboard. 

 

Click the Change Panel button to scroll through up to five screen panels in the 

whiteboard session. As a tutor, you can preload them with content for a tutoring session 
with text or drawings. The panel number appears below this button. 

 

Click the Select button to use an arrow to select areas of the whiteboard. 

 

Click the Typing Tool to enter text on the whiteboard. You can also copy and paste text 

from other applications and paste into the text box. 

 

Click the Drawing Tool to draw on the whiteboard. 
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Button Function 

 

Click the Eraser Tool to erase areas of the whiteboard. 

 

Click the Foreground Color button to change the color of the text or lines you place on 

the whiteboard. 

 

Click the Background Color button to change the color of the whiteboard background. 

 

Click the Toggle Grid button to turn a grid on/off on the whiteboard. 

 

Click the Upload File button to upload a file to the whiteboard. 

 

Click the Save button to save the contents of a whiteboard as a .jpg image file. 

 

Click the Exit Session button to leave the current whiteboard session. 

7. When a student wishes to come in for tutoring, they request permission to join the 
session. You can then accept their request. 

Once a student is in a 
session with you, can 
grant rights to the 
student to allow them 
to draw or write 
answers to questions 
you pose. You can 
also message the 
entire group or 
individual students: 
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11.2. Controlling Students in Research Center 

When you are logged into the Research Center, you have several options available to you 
to control student behavior. These actions are available via buttons in the messaging 
windows in the Research Center. 

11.2.1. PM (Private Message) 

You can PM a selected student or group of students. Only the selected student(s) will 
receive your message. 

1. From the list of students on 
the left of the Research 
Center window, click the 
checkbox next to the 

student(s) you wish to 
message, then click the PM 

button: 

 

2. Notice the arrow in your blue text entry 
box is now pointing at the PM box. This 
indicates that you are PM’ing instead of 
messaging everyone in the room: 

 

 

 

11.2.2. Silence 

If a student is being disruptive, you can prevent them from communicating with others by 
using the Silence button. 

1. From the list of students on 
the left of the Research 
Center window, click the 
checkbox next to the 

student(s) you wish to 
silence, then click the 
Silence button: 
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2. A confirmation appears to 
verify your action. Click 
Yes. 

3. Notice the student(s) name 
is now grayed out. This 
indicates that they have 
been silenced. They will 
stay silenced until you or 
another tutor or 
administrator unsilences 
them: 

 
4. The student receives a 

notice: 

 

 

 

 

 

To unsilence a student, place a check by their name and click the Silence button again. 

11.2.3. Boot 

You can also boot a disruptive student from the Research Center. Note that they can log 
back in, however. 

1. From the list of students on 
the left of the Research 
Center window, click the 
checkbox next to the 

student(s) you wish to 
silence, then click the Boot 

button: 
2. A confirmation appears to 

verify your action. Click Yes. 

3. The system verifies your 
action: 
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4. The student receives a 
notice that their connection 
to the Research Center has 
been closed: 

 

 

 

11.2.4. Report Abuse 

If a student’s behavior warrants notification of administrative staff, use the Report Abuse 
button. 

1. From the list of students on 
the left of the Research 
Center window, click the 
checkbox next to the 

student(s) you wish to 
silence, then click the Boot 

button: 

 

2. The Report Chat Abuse form 
appears: 

 
 

3. Enter the date and time of the 
incident and an explanation, 
then click Submit. 


